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� � � � � � � � � � � 	 
 � � � � 
 � � � � � � � � � � � � � � � � �
 
·  EndNote là ph� n m� m qu� n tr� c$ s�  d�  li� u giúp l� u tr�  và qu� n lý danh m! c tài li� u trích 

d� n/tài li� u tham kh� o. 
·  EndNote là công c!  � �  t� o danh m! c tài li� u trích d� n/tài li� u tham kh� o trong bài vi� t. 
·  EndNote c( ng là m� t công c!  tìm ki� m tài li� u tr� c tuy� n.  
·  Ph� n h� 
 ng d� n sau � ây là dành cho phiên b� n EndNote X1. 

 

� � � � � � � � � 	 
 � � � � � � � � � � � � � � � � � � � � � � � � � � � � �  � !� �
 
1. Vào trang web www.endnote.com 
2. T"  menu bên trái ch� n “Download a Free Trial”  
3. � i� n vào form và làm các b� 
 c theo h� 
 ng d� n � �  cài � 
 t ph� n m� m EndNote. 

 
L� u ý: 
 

·  B� n dùng th�  này có hi� u l� c trong vòng 01 tháng, k�  t"  ngày � � u tiên b� n b#t � � u s�  d! ng 
ch� $ng trình.  

·  Trong vòng 01 tháng dùng th� , t� t c�  m� i ch� c n� ng, công c!  c&a ch� $ng trình EndNote � � u có 
th�  s�  d! ng � � 	 c. 

·  Sau th� i h� n 01 tháng dùng th� , ch� $ng trình s)  t�  � � ng chuy� n � � i thành phiên b� n EndNote 
Viewer. 

·  Các ch� c n� ng có th�  s�  d! ng trong EndNote Viewer: 
o M�  các file EndNote; 
o Tìm ki� m, s#p x� p và in các tài li� u tham kh� o. 

·  V
 i EndNote Viewer, ng� � i s�  d! ng không th� : 
o B�  sung ho
 c ch�nh s� a các tài li� u tham kh� o trong file � ã có t"  10 tài li� u tham kh� o 

tr�  lên; 
o � �nh d� ng trên 10 tài li� u trích d� n tr�  lên trong m� t bài vi� t; 
o Tìm ki� m trên 10 tài li� u tham kh� o t"  m� t c$ s�  d�  li� u tr� c tuy� n; 
o Nh� p kh� u trên 10 tài li� u tham kh� o; 
o Xu� t kh� u trên 10 tài li� u tham kh� o t� i m� t th� i � i� m. 

 

" � � � �# $�%&� � � ' � � (� )� � � � � � � � � � �
 
EndNote � � � c cài � � t �  � âu? 
 
B� n c� n cài � 
 t EndNote vào �  C:\Program Files. M� t khi � ã cài � 
 t xong, nh� n vào nút Star t và tìm 
trong ph� n Programs. 
 
T� o m� t file EndNote m� i 
 
File EndNote là m� t c$ s�  d�  li� u (CSDL) l� u tr�  thông tin v�  t� t c�  các tài li� u tham kh� o c&a b� n. 
M
 c dù EndNote cho phép b� n t� o ra r� t nhi� u file nh� ng chúng tôi khuyên b� n ch� nên t� o 1 file � �  l� u 
t� t c�  các thông tin v�  tài li� u tham kh� o c&a b� n vì vi� c này s)  khi� n b� n d* qu� n lý và làm vi� c v
 i 
chúng h$n, nh� t là trong m� t th� i gian dài. 
 
� i� u � � u tiên c� n làm khi b#t � � u s�  d! ng EndNote là t� o m� t file m
 i cho b� n thân mình. Sau � ây là 
các b� 
 c c!  th� : 
 

1. M�  ch� $ng trình EndNote. Có 2 cách: 
2. M� t c� a s�  xu� t hi� n yêu c� u b� n Get star ted with EndNote 9. 
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3. Ch� n nút "Create a new EndNote library". 
4. Nh� n nút OK và màn hình sau � ây s)  xu� t hi� n:  
 

 
 
5. � 
 t tên file m
 i c&a b� n.  
6. L� u vào th�  m! c C:\Program Files\EndNote 9\Examples ho
 c vào b� t c�  th�  m! c nào b� n 

mu%n.  
7. Ch� n Save. 
 

Bây gi�  b� n � ã có m� t file m
 i � �  b#t � � u nh� p d�  li� u.  
 
	 óng và m�  m� t file 
 
� �  � óng m� t file, nh� n vào nút File trên thanh công c!  và sau � ó ch� n Close L ibrary ho
 c b� m � +ng 
th� i phím Ctr l và W. 
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� �  m�  l� i file EndNote: 
 
T"  nút File, ch� n Open. File m
 i c&a b� n và b� t k,  file EndNote nào mà b� n có s)  xu� t hi� n trên thanh 
d� c nh�  hình bên d� 
 i. 
 
Chú ý: ph� n m� m EndNote s)  � óng hoàn toàn khi ch� n nút File trên thanh công c!  và nh� n vào nút 
Exit, ho
 c khi nh� n vào nút  �  góc trên cùng bên ph� i màn hình. T� t c�  các thay � � i, c� p nh� t g� n 
nh� t b� n � ã th� c hi� n s)  � � 	 c l� u l� i. 
 
N� u b� n � ã thoát kh' i ch� $ng trình, hãy m�  EndNote và tìm file trong th�  m! c mà b� n � ã l� u b ng 
cách ch� n File > Open > Open L ibrary… 
 

 
 

" � � � � * $� � � + � � � , � � � � � � � 	 
 � � - � �)� � � � � � !� � � � . � / � � 0 � �1 � � � � �
 
Nh
 p thông tin v�  m� t tài li� u trích d
 n m� i 
 
Bao g+m các b� 
 c: 
 

1. M�  file � ã có s� n ho
 c t� o file m
 i (xem B� � c 1) 
2. Ch� n References > New Reference. 
3. M� t bi� u m� u (form) r� ng hi� n ra � �  b� n nh� p d�  li� u.  
 

 
 
Ch� n ki� u tài li� u 
 

T"  ô Reference Type  , m�  menu d� c. T"  � ây b� n s)  th� y 
danh sách các ki� u tài li� u khác nhau � �  b� n ch� n. Ví d!  ki� u tài li� u ng� m � �nh là Journal Article (bài 
báo chuyên ngành). Ki� u tài li� u này có th�  s�  d! ng cho c�  bài báo in và bài báo � i� n t� /tr� c tuy� n.  
 
M� i ki� u tài li� u s)  có m� t bi� u m� u v
 i nh� ng thông tin phù h	 p v
 i t" ng d� ng tài li� u.  
 
Ví d! :  
 
- Journal Article (bài báo chuyên ngành): bi� u m� u này s)  có các thông tin: Journal (tên báo/t� p chí), 
Volume (quy� n), Issue (t� p) trong t�  khai tr#ng.  
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- Book (sách): bi� u m� u này có các thông tin khác, ví d!  nh�  City (thành ph% - n$i xu� t b� n) và 
Publisher (nhà xu� t b� n). 
 
Thông tin chi ti� t v�  lo� i tài li� u s)  � � 	 c trình bày �  B� 
 c 5: Các lo� i tài li� u. 
 
Nh
 p thông tin v�  các tài li� u trích d
 n 
 
Ví d! : s�  d! ng lo� i tài li� u là Journal Ar ticle và hãy nh� p các thông tin (xem hình d� 
 i). 
 
� �  con tr'  vào ô Author và nh� p các thông tin v�  tác gi� : 
 
M� i tác gi�  ph� i nh� p vào m� t dòng riêng (nh� p xong tác gi�  th�  nh� t, nh� n phím Enter � �  xu%ng dòng 
nh� p ti� p tác gi�  th�  hai).  
 

·  V
 i tên tác gi�  Âu-M- , tr� t t�  nên s�  d! ng là H� , Tên � � m. (nên vi� t � � y � &, xem ví d!  �  hình 
minh h� a phía d� 
 i � ây).  
Ví d! : Saurus, Tyrone. ho
 c van Beethoven, Ludwig. ho
 c de Villepin, Dominique. 

·  V
 i tên tác gi�  Vi� t Nam, tr� t t�  nên s�  d! ng là H� , � � m Tên.  
Ví d! : Nguy� n, V� n Lâm. 

·  N� u tác gi�  là c$ quan, t�  ch� c thì ph� i � 
 t d� u ph� y �  cu%i tên, ví d! : Bedrock Paleontological 
Society, ho
 c Vi� n Khoa h� c Xã h	 i, 

 
Làm nh�  v� y � �  EndNote phân bi� t � � 	 c h� , tên c&a tác gi� , � +ng th� i giúp cho vi� c thay � � i ki� u trích 
d� n m� t cách d* dàng, phù h	 p v
 i các ki� u trích d� n thông d! ng hi� n � ang � � 	 c s�  d! ng nhi� u. 
 
Chú ý: tên tác gi�  s)  có màu � '  n� u � ây là l� n � � u tiên b� n nh� p tên tác gi�  (cá nhân ho
 c c$ quan, t�  
ch� c) này vào file � ang m� . Sau này n� u b� n có tài li� u tham kh� o khác c( ng có tác gi�  là cá nhân ho
 c 
c$ quan t�  ch� c � ã có tên trong file này thì EndNote s)  t�  � � ng nh� n ra và ch� c� n b� n � ánh vài t"  � � u 
tiên là nh� ng tên t� $ng t�  s)  hi� n ra � �  b� n l� a ch� n mà không ph� i � ánh l� i t� t c�  các t" . 
 

 

 
 
� � a con tr'  vào ô Year  � �  nh� p n� m xu� t b� n c&a tài li� u (ho
 c dùng phím TAB trên bàn phím � �  
chuy� n � � n ô ti� p theo). 
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Ti� p t! c nh� p thông tin vào các ô còn l� i. Không c� n thi� t ph� i nh� p s% li� u vào t� t c�  các ô. Tuy nhiên 
n� u có nhi� u thông tin thì s)  t%t h$n. EndNote s)  t�  t� o các danh m! c v
 i các thông tin c� n thi� t cho 
t" ng ki� u trích d� n mà b� n ch� n. 
 
Dùng các ch�  vi� t hoa cho cho các t"  c� n thi� t, ví d! : tên riêng, ch�  vi� t t#t,… 
 
Không c� n ph� i � i� n các d� u câu (. , ; : v.v.) ho
 c ho
 c các ch�  nh�  vol., p., tr., quy� n, t� p, … 
 
M� t s% thông tin h� u ích khác nên nh� p vào file EndNote: 
 
Label: (nhãn) s�  d! ng cho b� t k,  thông tin gì, ví d! : tên c&a khóa h� c/môn h� c ho
 c công trình nghiên 
c� u mà b� n � ang th� c hi� n. Sau này b� n có th�  tìm trong EndNote t� t c�  các tài li� u b� n � ã � � c/tìm th� y 
cho khóa h� c/môn h� c… này. 
 
Keywords: (t"  khóa) các t"  mô t�  ch& � �  c&a tài li� u. 
 
Abstract: (tóm t#t) tóm t#t n� i dung c&a tài li� u.  
 
Notes: (ghi chú) dùng cho b� t k,  thông tin gì, ví d! : nh� n xét, � ánh giá c&a b� n v�  tài li� u này. 
 
URL: ô này có th�  s�  d! ng n� u � ó là tài li� u tr� c tuy� n ho
 c th� m chí là m� t file trong máy tính c&a 
b� n. � �  m�  tài li� u ra, b� n ch� vi� c nh� n vào � � � ng d� n � ó, ho
 c ch� n References > Open Link, ho
 c 
b� m � +ng th� i 2 phím Ctrl và G. 
 

 
 
L� u m� t tài li� u 
 
Tài li� u tham kh� o c&a b� n s)  � � 	 c t�  � � ng l� u l� i khi b� n � óng c� a s�  mà b� n � ang nh� p d�  li� u l� i. 
Mu%n � óng c� a s�  nh� p d�  li� u c&a 1 tài li� u tham kh� o, nh� n vào nút  th�  2 tính t"  góc trên bên ph� i 
màn hình, ho
 c nh� n � +ng th� i 2 phím Ctrl và F4. N� u b� n tình c�  nh� n vào nút  � � u tiên �  góc trên bên 
ph� i màn hinh, ch� $ng trình EndNote s)  � óng l� i hoàn toàn và s)  l� u l� i toàn b�  nh� ng thay � � i b� n � ã 
th� c hi� n g� n nh� t.  
 
Chú ý quan tr� ng: Sao l� u d�  li� u! 
 
Khi � ã nh� p d�  li� u vào file, � ây là lúc b� n c� n sao l� u d�  li� u � �  phòng tr� � ng h	 p có s�  c% v
 i �  c� ng 
máy tính b� n dùng. N� u file c&a b� n không quá l
 n (t%i � a là 3000 tài li� u tham kh� o), b� n có th�  d* 
dàng l� u tr�  vào � .a USB ho
 c � .a m� m 1,44Mb. Nên nh
  là b� n � ã m� t khá nhi� u công s� c � �  nh� p d�  
li� u. D� 
 i � ây là cách sao l� u: 
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T"  File, ch� n Save a Copy. 
 
Ch� n tên file m
 i, ho
 c gi�  nguyên tên c( . N� u b� n gi�  nguyên tên file c( , EndNote s)  t�  � � ng thêm t"  
copy vào cu%i tên file sao l� u. Ví d! : kinhte copy.enl 
 
Soát l� i chính t�  (ti� ng Anh) 
 
Khi b� n hoàn t� t vi� c nh� p d�  li� u cho m� t tài li� u, b� n có th�  soát l� i chính t�  (ch� dành cho ti� ng Anh). 
Ch� có th�  soát l� i chính t�  cho t" ng tài li� u, khi b� n � ang m�  màn hình v�  tài li� u � ó. Có 3 cách kích 
ho� t ch� c n� ng soát l� i chính t� : 
 

�  T"  Tools, ch� n Spell Check  
�  ho
 c nh� n � +ng th� i 2 phím CTRL và Y 
�  ho
 c nh� n vào bi� u t� 	 ng   trên thanh công c! . 

 
Xem tr� � c ki� u trích d� n  
 
Nh� n v� o n� t Show Preview    �  g� c d� 
 i c� ng b� n ph� i m� n h�nh, b� n s)  xem tr� 
 c 
� � 	 c c� ch hi� n th� c&a t� i li� u trong danh m! c t� i li� u tr�ch d� n/t� i li� u tham kh� o theo ki� u tr�ch d� n 
hi� n � ang � � 	 c ch� n.  
 

" � � � �2 $� � � 3 � � � � , � � � � � � � 	 
 � � - � �)� � � � � � 0 � �1 � � � � 	 - � � 	 4 � � � � � �
56 7 8 9 : � �
 
Tr�ch d
 n trong khi vi� t v�  ch� c n� ng � �nh d� ng t� c th� i (instant formatting) 
(Word 2003) 
 
M�  m� t file Word s� n c� . N� u thanh c� ng c!  EndNote (xem h�nh d� 
 i � 	 y) ch� a xu� t hi� n trong file 
Word th� b� n ph� i k�ch ho� t thanh c� ng c!  EndNote trong ch� $ng tr�nh Word b ng c� ch nh� n v� o n� t 
View > Toolbars > EndNote X1. 
 

 
 
Ch� c n� ng � �nh d� ng t� c th� i cho ph
 p t�  � � ng � �nh d� ng ki� u tr�ch d� n v�  d� ng tr�nh b� y trong danh 
m! c t� i li� u tham kh� o ngay khi b� n chèn m� t tr�ch d� n v� o v� n b� n Word. � �  k�ch ho� t ch� c n� ng n� y, 

nh� n chu� t v� o n� t Format Bibliography  tr� n thanh c� ng c!  EndNote trong v� n b� n Word. Ch� n 
tab Instant Formatting, ti� p � �  nh� n v� o n� t Turn On � �  k�ch ho� t ch� c n� ng n� y ho
 c n� u � �  hi� n 
ch�  Turn Off  r+i th� gi�  nguy� n (ch� c n� ng � �  � � 	 c k�ch ho� t).  
 
Chèn m� t tr�ch d
 n m� i 
 

1. � �  con tr'  v� o n$i b� n mu%n chèn th� ng tin v�  t� i li� u tr�ch d� n. 

2. Quay tr�  l� i ch� $ng tr�nh EndNote, b� n c�  th�  nh� n v� o n� t   t� i thanh c� ng c!  EndNote. 
3. T"  file EndNote, t�m t� i li� u m�  b� n mu%n chèn th� ng tin tr�ch d� n v�  nh� n chu� t v� o t� i li� u � �  

(kh� ng c� n m�  ra). 

4. Quay l� i v� n b� n Word v�  nh� n v� o n� t Inser t Selected Citation  �  thanh c� ng c!  EndNote. 
Th� ng tin v�  t� i li� u tr�ch d� n s)  xu� t hi� n trong � o� n v� n c( ng nh�  trong danh m! c t� i li� u tr�ch 
d� n / t� i li� u tham kh� o �  cu%i t� i li� u. 

 
C� c ph� n m� m so� n th� o v� n b� n kh� c c( ng c�  th�  t�ch h	 p EndNote, tuy nhi� n c� ch thao t� c s)  kh� c 
nhau. EndNote l� m vi� c t%t nh� t trong 2 ph� n m� m MS Word v�  WordPerfect. Xem trong cu%n H� 
 ng 



 9 
d� n s�  d! ng c&a EndNote � �  bi� t th� ng tin v�  c� ch thao t� c tr� n WordPerfect v�  c� c ph� n m� m so� n 
th� o v� n b� n kh� c. 
 

" � � � � ; $�< =� � � � &� � � � ' � � � 0 � � � � > � � � - � � )� � � � � � 0 � �1 � � � �
 
Tr�ch d� n c&a b� n s)  � � 	 c � �nh d� ng t�  � � ng trong m� t h�  th%ng c� c ki� u tr�ch d� n ng� m � �nh c&a 
EndNote. B� n c�  th�  � �nh d� ng l� i c� c ki� u tr�ch d� n n� y theo ki� u m�  b� n mu%n. 
 

Tr� n thanh c� ng c!  EndNote, nh� n v� o n� t Format Bibliography  . M� t h� p tho� i s)  xu� t hi� n.  
 

 
 
Danh m! c t� i li� u tham kh� o c&a b� n s)  � � 	 c � �nh d� ng theo ki� u � � 	 c l� a ch� n trong �  With output 
style. B� n c�  th�  ch� n m� t ki� u � �nh d� ng m
 i t"  menu d� c � �  � �nh d� ng l� i danh m! c t� i li� u tham 
kh� o c&a b� n. 
 
Tìm c� c ki� u � �nh d� ng kh� c 
 
T� i h� p tho� i With output style ch� c�  v� i ki� u tr�ch d� n cho b� n l� a ch� n. � �  ch� n m� t ki� u tr�ch d� n 
kh� c t"  h� ng tr� m ki� u tr�ch d� n c�  s� n trong ph� n m� m EndNote, nh� n chu� t v� o n� t Browse v�  ch� n 
m� t ki� u trong danh m! c x� p theo v� n ch�  c� i. 
 
S� a tr�ch d
 n trong � o� n v� n  
 
Nh� n chu� t v� o th� ng tin v�  t� i li� u tr�ch d� n m�  b� n v" a m
 i chèn v� o v� n b� n. Th� ng tin v�  t� i li� u 
tr�ch d� n s)  � � 	 c � � nh d� u b ng m� u n	 u. 
 

Nh� n v� o n� t Edit Citation tr� n thanh c� ng c!  EndNote trong v� n b� n Word .  
 
M� t h� p tho� i s)  xu� t hi� n (xem h�nh d� 
 i � 	 y) trong � �  b� n c�  th�  ch�nh s� a th� ng tin v�  t� i li� u tr�ch 
d� n. V� d! : n� u b� n � �  s�  d! ng t� n t� c gi�  trong c	 u v� n v�  kh� ng mu%n n�  xu� t hi� n n� a,  b� n c�  th�  
nh� n v� o �  Exclude author . B� n c( ng c�  th�  th� m s% trang v� o �  Suffix.  
 
C� c t� y ch� n kh� c c( ng c�  th�  thay � � i, v� d!  nh�  b'  th� ng tin v�  n� m xu� t b� n ho
 c th� m t"  v� o � � u 
ho
 c cu%i th� ng tin v�  t� i li� u tr�ch d� n. 
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Khi � �  ho� n th� nh vi� c ch�nh s� a, nh� n v� o n� t OK, v�  nh� ng thay � � i b� n � �  th� c hi� n s)  � � 	 c � p 
d! ng. 
 

" � � � �? $� � � @� � �A� 0 �� � � � )� &�� � - � � )� � � � �
 
C� c ki� u tr�ch d
 n - m
 u cho s� n 
 
/  B� 
 c 2, b� n � �  h� c c� ch ch� n m� t ki� u t� i li� u ph�  h	 p v
 i t� i li� u b� n � ang nh� p v� o file EndNote. 
M� i lo� i t� i li� u c� n nh� p nh� ng th� ng tin kh� c nhau. V� d! : m� t b� i b� o chuy� n ng� nh c� n c� c th� ng 
tin v�  t� n b� i b� o, t� c gi� , t� n t�  b� o, quy� n, t� p, n� m v�  s% trang. M� t cu%n s� ch l� i c� n nh� ng th� ng tin 
kh� c, v� d! : t� n cu%n s� ch, t� c gi� , nh�  xu� t b� n, n$i xu� t b� n (t� n th� nh ph%) v�  n� m xu� t b� n. Khi m�  
m� t c� a s�  nh� p li� u m
 i, m� u cho s� n s)  cung c� p c� c �  m�  b� n c� n nh� p th� ng tin c� n thi� t v�  t� i li� u 
tham kh� o v� o. 
 
Ch�nh s� a v�  c�  nhân hóa c� c lo� i t� i li� u  
 
N� u b� n mu%n b�  sung th� ng tin v� o m� t m� u cho s� n, v� d! : mu%n th� m m� t �  nh� p li� u, ho
 c b� n 
mu%n b'  b
 t � i m� t s% � , quy tr�nh ti� n h� nh nh�  sau: 
 
Ch� n Edit > Preferences > Reference Types > Modify Reference Types 
 
Ch� n t"  menu d� c lo� i t� i li� u m�  b� n mu%n s� a � � i th� ng tin tr�ch d� n. Lo� i ng� m � �nh l�  Journal 
Ar ticle (b� i b� o chuy� n ng� nh). B� n c�  th�  thay � � i th� ng tin �  c� t b� n ph� i. 
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S�  d! ng thanh tr� 	 t d� c � �  xem/s� a c� c � . 
 
� � i khi b� n c�  th�  mu%n th� m v� i �  m
 i v� o m� t lo� i t� i li� u tham kh� o ± hay c�  khi t� o ra h0n m� t lo� i 
h�nh t� i li� u m
 i trong EndNote, s�  d! ng m� t m� u cho s� n ch� a s�  d! ng (xem �  ph�a d� 
 i c� ng c&a c� c 
m� u cho s� n trong h� p tho� i Edit Reference Types).  
 
Trong tr� � ng h	 p n� y b� n c� n ch�nh s� a l� i ki� u danh m! c t� i li� u tham kh� o � �  th� m �  nh� p li� u m
 i. 
Xem �  B� � c 6: S
 a � � i các ki
 u danh m� c tài li� u tham kh� o. 
 

" � � � �B$�C� 0 �DE�� � � � �1 �F� � � 0 � � � � > � � � - � �)� � � � � � 0 � �1 � � � � �
 
Ch�nh s� a ki� u tr�ch d
 n hi� n có 
 
� � i khi ki� u tr�ch d� n c�  trong EndNote c�  th�  kh� c � � i ch� t v
 i ki� u m�  b� n mu%n ho
 c � � 	 c y� u c� u 
ph� i l� m theo. V� v� y, b� n c� n ph� i ch�nh s� a ki� u tr�ch d� n � �  cho th� ng tin tr�ch d� n trong v� n b� n c&a 
b� n � � 	 c � �nh d� ng ph�  h	 p v
 i y� u c� u. 
 
Xem th� ng tin �  thanh c� ng c!  EndNote v�  ki� u tr�ch d� n � ang ch� n. N� u � 	 y kh� ng ph� i l�  ki� u b� n 
c� n ch�nh s� a, nh� n chu� t v� o menu d� c v�  nh� n Select Another Style � �  ch� n m� t ki� u t"  trong danh 
s� ch. � �  ch�nh s� a ki� u tr�ch d� n n� y, nh� n v� o n� t Edit > Ouput Styles > v�  Edit APA 5th (ho
 c b� t 
c�  ki� u tr�ch d� n n� o m�  b� n mu%n ch�nh s� a). 
 
H� y nh�n v� o menu b� n tr� i m� n h�nh. Ph� ng to menu Citations � �  c�  th� m th� ng tin v�  c� ch hi� n th� 
c&a th� ng tin v�  t� i li� u tr�ch d� n trong � o� n v� n c( ng nh�  trong danh m! c t� i li� u tham kh� o. 
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Ch� n Citations > Templates � �  xem c� c th� ng tin cho s� n � %i v
 i tr�ch d� n t� i � o� n v� n. Ch� n 
Bibliography > Templates � �  xem th� ng tin � � 	 c hi� n th� trong danh m! c t� i li� u tham kh� o.  
 

 
 
� �  thay � � i � �nh d� ng th� ng tin v�  t� i li� u tr�ch d� n, b� i � en t" /c! m t"  m�  b� n mu%n s� a. S�  d! ng c� c 
n� t tr� n thanh c� ng c!  v�  menu gi%ng nh�  c� ch b� n l� m trong Word. 
 
B� n c( ng c�  th�  thay � � i c� c th� ng tin v�  d� u c	 u s�  d! ng trong m� t tr� � ng c!  th�  n� o � � . B� n c� n ph� i 
l� m � i� u n� y n� u, v� d! , b� n � �  s� a � � i m� t ki� u tr�ch d� n trong � �  bao g+m vi� c th� m m� t th� ng tin 
m
 i (xem B� � c 5). 
 
B�  sung ký t�  � � c bi� t  
 
/  t� t c�  c� c m� u cho s� n � � u c�  nh� ng k�  t�  � 
 c bi� t. � 	 y l�  nh� ng k�  t�  c&a EndNote ki� m so� t  vi� c 
hi� n th� th� ng tin trong m� t s% tr� � ng h	 p c!  th� . T� t c�  nh� ng k�  t�  n� y c�  th�  th� m v� o th� ng qua 
menu Inser t Field. 
 

1. S% �t / s% nhi� u: d� u m(  ^ - s�  d! ng k�  hi� u n� y n� u c�  s�  kh� c nhau v�  s% �t v�  s% nhi� u, v� d!  
ch�  p. n� u ch� c�  1 trang v�  pp. n� u c�  nhi� u trang. 

2. Ph� n li� n k� : � 	 y l�  ph� n kh� ng ng#t qu� ng v�  � � 	 c hi� n th� b ng h�nh thoi nh'  trong template. 
K�  t�  n� y c�  t� c d! ng n%i th� ng tin li� n k�  v
 i m� t �  kh� ng c�  th� ng tin, nh m tr� nh m� t 
kho� ng tr%ng kh� ng c� n thi� t n� u c�  m� t �  kh� ng c�  th� ng tin. V� d!  n� u m� t t� i li� u d� ng s� ch 
kh� ng c�  n$i xu� t b� n, th� ng tin n� y s)  � � 	 c b'  qua v�  EndNote s)  hi� n th� lu� n th� ng tin ti� p 
theo (v� d! : nh�  xu� t b� n). 

3. D� u ng#t b#t bu� c: d� u s�  th0ng | - s�  d! ng � �  ng#t c	 u b#t bu� c t"  nh� ng th� ng tin li� n k� . V� 
d! : b� n mu%n � 
 t m� t d� u ch� m �  cu%i m� t tr�ch d� n trong danh m! c kh� ng ph!  thu� c v� o vi� c 
th� ng tin n� o c�  xu� t hi� n. 

4. T� n tr� � ng nh�  l�  m� t t"  trong danh m! c: d� u huy� n tr� n b� n ph�m ` - s�  d! ng d� u n� y n� u b� n 
mu%n s�  d! ng t� n tr� � ng trong danh m! c tr�ch d� n c&a m�nh. V� d! : n� u b� n mu%n s�  d! ng t"  
“year ”  � i li� n v
 i s% c&a n� m xu� t b� n trong danh m! c, c� n ph� i s� a trong template l�  `year`, khi 
� �  trong danh m! c s)  xu� t hi� n Year  2001. 

 
D� 
 i � 	 y l�  v� d!  v�  c� ch chèn t� m t#t t� i li� u trong danh m! c t� i li� u tham kh� o: 
 

1. Ch� n 1 ki� u tr�ch d� n mu%n ch�nh s� a, v� d! : Harvard: t"  Edit > Output Styles > Open Style 
Manager  > Harvard > Edit. 

2. V� o menu File > Save As > ch� n ki� u tr�ch d� n m
 i, v� d!  Harvard Annotated.ens 
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3. T"  menu b� n tr� i, ch� n Templates trong m! c Bibliography. 
4. Nh� n v� o m! c Journal Ar ticle. � �  con tr'  v� o cu%i template n� y. Nh� n v� o n� t Inser t Field v�  

nh� n v� o Forced Separation, sau � �  ch� n End of Paragraph > Abstract. � � ng c� a s�  n� y l� i 
� �  l� u l� i nh� ng thay � � i.  

5. Quay tr�  l� i file EndNote v�  ch� n m� t b� i b� o c�  ph� n t� m t#t. Nh� n v� o b� i b� o � �  � �  xem n�  
� � 	 c hi� n th� nh�  th�  n� o. 

 

 
 
6. T"  File, ch� n Close Style > Yes � �  l� u l� i nh� ng thay � � i.  
 

" � � � �G$� � � + �1 � H� � � � , � � � � � � � � I � � 
 �AJ � � K�)� � � �
 
Xu� t d�  li� u tr� c ti	 p (Direct export)  
 
L�  c� ch nh� p d�  li� u � $n gi� n nh� t t"  m� t c$ s�  d�  li� u v� o file EndNote c&a b� n. � i� u n� y c�  ngh.a l�  
b� n ch� c� n nh� n v� o m� t � � � ng d� n trong c$ s�  d�  li� u v�  nh� ng t� i li� u tham kh� o � � 	 c ch� n s)  t�  
� � ng � � 	 c chèn v� o file EndNote c&a b� n. Hi� n t� i, kh� ng ph� i c$ s�  d�  li� u n� o c( ng h�  tr	  ch� c n� ng 
n� y.  
 
� %i v
 i nh� ng c$ s�  d�  li� u c�  cung c� p ch� c n� ng n� y, quy tr�nh ch�nh x� c s)  c�  nh� ng kh� c bi� t. 
Nh�n chung, s)  c�  m� t � � � ng d� n c�  t� n ki� u nh�  “direct expor t” , “export directly to EndNote”  hay 
“expor t to reference manager ” , “Download all highlighted to citation manager” . Ch� n nh� ng t� i 
li� u tham kh� o b� n mu%n xu� t d�  li� u v�  nh� n v� o n� t xu� t d�  li� u.  
 
T� y thu� c v� o c$ s�  d�  li� u b� n � ang s�  d! ng, b� n c�  th�  � � 	 c y� u c� u, v� d!  nh�  b� n mu%n xu� t d�  
li� u nh� ng t� i li� u � �  ch� n hay xu� t d�  li� u to� n b�  nh� ng t� i li� u t�m � � 	 c, v�  b� n c�  mu%n xu� t d�  
li� u c�  ph� n t� m t#t hay kh� ng. Sau � �  c$ s�  d�  li� u s)  h' i b� n mu%n xu� t d�  li� u d�  li� u v� o file 
EndNote n� o. Sau khi c� c t� i li� u � �  � � 	 c nh� p kh� u v� o file EndNote, c� c t� i li� u v" a � � 	 c nh� p kh� u 
s)  hi� n th� ri� ng r)  so v
 i nh� ng t� i li� u � �  c�  tr� 
 c � � , vi� c n� y cho ph
 p b� n ki� m tra v�  lo� i b'  nh� ng 
t� i li� u b� n kh� ng c� n.  
 
B� n n� n ki� m tra xem t� t c�  c� c d�  li� u b� n c� n � �  � � 	 c nh� p kh� u ch� a v�  � �  xu� t hi� n ch�nh x� c trong 
c� c tr� � ng ch� a. N� u nh�  ki� u tr�ch d� n c&a b� n y� u c� u, b� n c� n ph� i nh� p th� ng tin v�  ng� y b� n truy 
nh� p c$ s�  d�  li� u v�  t� n c&a c$ s�  d�  li� u trong c� c tr� � ng Access Date v�  Name of Database. � �  l� m 
vi� c n� y, ch� n menu References, ti� p � �  ch� n Change and Move Fields v�  l� m theo c� c b� 
 c sau: 
 

·  Ch�  �  tab Change Fields ph� i � � 	 c m� .  
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·  T"  menu d� c ch� n Access Date, ti� p � �  nh� n v� o h� p Include a space after  the new text 

(thay � � i gi�  tr� th� nh 0).  
·  Trong h� p m� u tr#ng, nh� p ng� y th� ng hi� n h� nh (v� d! : January 12, 2006) sau � �  nh� n OK.  
·  Ng� y th� ng s)  � � 	 c chèn v� o tr� � ng Access Date c&a t� t c�  c� c t� i li� u tham kh� o m
 i � � 	 c 

nh� p kh� u.  
·  L
 p l� i nh� ng thao t� c n� y � �  nh� p t� n c&a c$ s�  d�  li� u (v� d!  Science Direct) v� o tr� � ng 

Name of Database.  
 
� �  xem t� t c�  c� c t� i li� u tham kh� o, ch� n menu References >> Show All References. 
 
B�  l� c (Filters) 
 
M� t s% c$ s�  d�  li� u kh� ng c�  ch� c n� ng xu� t d�  li� u tr� c ti� p nh� ng cho ph
 p b� n download c� c t� i 
li� u tham kh� o � �  ch� n nh�  l�  m� t file text sau � �  � � a c� c d�  li� u n� y v� o file EndNote th� ng qua ch� c 
n� ng l� c (filter ). EndNote c�  r� t nhi� u b�  l� c v�  nh� ng b�  l� c n� y c�  th�  download v�  t"  trang web c&a 
EndNote ho
 c c� c trang web kh� c. 
 
Gi%ng nh�  ch� c n� ng xu� t d�  li� u tr� c ti� p, quy tr�nh l� c c!  th�  s)  kh� c nhau cho t" ng c$ s�  d�  li� u.  
 
S
  d� ng m	 t b	  l� c � 
  nh� p kh� u d�  li� u t�  c�  s�  d�  li� u ERIC (Educational Resources 
Information Center )  
 
� �  ho� n th� nh quy tr�nh n� y, tr� 
 c h� t b� n c� n t�m ki� m trong c$ s�  d�  li� u. V� d! : t"  c$ s�  d�  li� u 
ERIC, ch� n m! c Advanced Search v�  ti� n h� nh t�m ki� m theo ch& � �  disability AND children.  
 

 
 
Ch� n 5 t� i li� u � � u ti� n r+i nh� n v� o n� t Update Marked L ist.  
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Ch� n n� t Save, Pr int, Email. Nh� n Save, ch�  �  ch� n � �nh d� ng PC.  
 

 
 
M� n h�nh download s)  xu� t hi� n y� u c� u b� n m�  ho
 c l� u l� i file csaresults.txt. Nh� n n� t Save � �  l� u 
file v� o desktop.  
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·  T"  EndNote, ch� n File >> Impor t. 
·  Nh� n v� o n� t Choose File. 
·  T�m file � �nh download t"  Desktop, ch� n csaresults.txt >> Open. 
·  Nh� n v� o menu Impor t Option v�  ch� n Other  Filters. 
·  Ch� n ERIC (CSA) t"  danh m! c v�  nh� n Choose. 
·  Nh� n v� o menu Duplicates v�  ch� n Discard Duplicates. 
 

 
 
·  Nh� n Impor t.  C� c t� i li� u tham kh� o � �  � � 	 c nh� p kh� u v� o file EndNote.  

M�  m� t s% t� i li� u xem ch� ng � �  � � 	 c nh� p kh� u ch�nh x� c ch� a, nh� t l�  c� c tr� � ng. B� n c�  th�  
th� m b� t c�  d�  li� u n� o n� u c� n.  

·  � �  xem to� n b�  file, ch� n References >> Show All References.  
 

" � � � �L $� � � + �1 � H� � � K�)� � � � � I � � ' � � � > � �)> � � � � � � 	 � � � �
5� � � � � � � � � � � (� )� A: �
 
Nh
 p kh� u d�  li� u b� ng connection files (file liên k� t) 
 
File li� n k� t cho ph
 p b� n t�m ki� m trong m� t danh m! c th�  vi� n t"  ph� n m� m EndNote. R� t nhi� u file 
li� n k� t trong EndNote l�  t"  c� c c$ s�  d�  li� u ph� i tr�  ti� n ± v�  c� c c$ s�  d�  li� u n� y th� � ng l�  kh� ng 
th�  s�  d! ng v� ch� ng c� n c�  password � �  truy c� p. V� v� y c� c file li� n k� t th� � ng d� nh cho c� c m! c l! c 
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th�  vi� n v�  c� c c$ s�  d�  li� u mi*n ph�, v� d!  nh�  PubMed. K� t qu�  c&a l� nh t�m ki� m s)  hi� n th� nh�  
l�  c� c t� i li� u tham kh� o trong EndNote, v�  c�  th�  l� u l� i trong file EndNote c&a b� n.  
 
Liên k� t t� i m� c l� c th�  vi� n tr� � ng 	 � i h� c C� ng ngh�  Curtin  
 
File li� n k� t c&a m! c l! c th�  vi� n tr� � ng � � i h� c Curtin kh� ng c�  s� n trong EndNote, m�  c� n ph� i 
download t"  trang  EndNote c&a trang web th�  vi� n Curtin v�  � � a v� o th�  m! c Connections trong 
EndNote. 
 
V� o trang web EndNote connection files c&a th�  vi� n � � i h� c Curtin 
http://library.curtin.edu.au/research_and_information_skills/endnote/connection_files.html v�  ch� n ho
 c 
l�  Windows ho
 c Macintosh. L� u file zip v� o desktop sau � �  nh� y k
 p v� o file n� y v�  � � a v� o th�  m! c 
C\Program Files\EndNote X1\Connections. B� n c� n ph� i � � ng v�  m�  l� i ch� $ng tr�nh EndNote � �  
file Cur tin-Aleph500 xu� t hi� n trong danh m! c file li� n k� t. 
 
T"  Tools ch� n Connect >> Connect � �  ch� n m� t file li� n k� t.  
 

 
 
EndNote s)  hi� n th� h� p tho� i Choose a Connection File. T�m file li� n k� t c&a m! c l! c th�  vi� n c� n 
t�m, Curtin-Aleph500.enz, v�  nh� n v� o n� t Choose.  
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EndNote s)  t� o ra m� t c� u n%i v
 i m! c l! c th�  vi� n n� y. 
 
Tìm ki� m trong m� c l� c th�  vi� n t  EndNote   
 
Khi ch� $ng tr�nh EndNote c&a b� n � �  � � 	 c li� n k� t v
 i m! c l! c th�  vi� n ho
 c l�  m� t c$ s�  d�  li� u, 
nh� p t"  kh� a, v� d!  jurassic v� o h� p tho� i t�m ki� m v�  nh� n n� t Search. 
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EndNote s)  hi� n th� m� t h� p tho� i g+m nh� ng t� i li� u t�m � � 	 c. Nh� n OK � �  ti� p t! c. C� c t� i li� u s)  
� � 	 c hi� n th� trong m� n h�nh EndNote. 
 
B� n c�  th�  ch� n nhi� u t� i li� u � �  copy v� o EndNote b ng c� ch nh� n v�  gi�  ph�m Shift ho
 c Ctr l v�  
nh� n v� o c� c t� i li� u c� n thi� t, ho
 c s�  d! ng ch� c n� ng Copy All To � �  nh� p kh� u t� t c�  c� c t� i li� u v� o 
file EndNote c&a b� n. 
 

�
 

" � � � �M$�N � � � � )O�(�)� � � � � � � � � �5AP �QR S�� � � �1 �R� S�	 - � � &� �
� � � � � � T� � � - � � )� � � : �
 
� �  c�  th�  th� c h� nh nh� ng b� i sau � 	 y, b� n n� n c�  m� t file EndNote c�  s� n nhi� u t� i li� u tham kh� o. 
Trong ch� $ng tr�nh EndNote c�  s� n m� t file m� u t� n l�  Paleo.enl � �  b� n c�  th�  th� c h� nh. File n� y 
� � 	 c l� u trong th�  m! c EndNote Examples. 
 



 20 

 
 
H� y t�m file n� y trong m� y t�nh c&a b� n v�  m�  ra. File s)  xu� t hi� n nh�  sau: 
 

 
 
Tìm ki� m c� c t� i li� u tr�ch d
 n trong file v�  s! p x� p  
 
Khi b� n m�  m� t file EndNote (nh�  th� y �  h�nh tr� n), b� n s)  c�  th�  nh�n th� y 3 tr� � ng sau � 	 y: 
 
Author  (h�  c� a tác gi�  � � u tiên) 
Year (n	 m xu
 t b� n)  
Title (nhan � � ) 
 
Th� ng th� � ng c� c t� i li� u tham kh� o � � 	 c s#p x� p theo v� n ch�  c� i c&a t� n t� c gi� . 
 
N� u mu%n thay � � i ti� u ch� s#p x� p c&a c� c t� i li� u tham kh� o, b� n ch� c� n nh� n v� o nh� ng �  Author, 
Year ho
 c Title. Nh� n v� o �  n� y l� n th�  2, b� n s)  thay � � i tr� t t�  s#p x� p t� ng d� n ho
 c gi� m d� n. Ch� c 
n� ng n� y r� t h� u �ch, v� d! , n� u b� n mu%n s#p x� p c� c t� i li� u tham kh� o theo tr�nh t�  n� m xu� t b� n t"  
t� i li� u c(  nh� t � � n t� i li� u m
 i nh� t. 
 

B� n c( ng c�  th�  s#p x� p theo c� c ti� u ch� kh� c nhau b ng c� ch s�  d! ng n� t s#p x� p  tr� n thanh c� ng 
c!  ch�nh.  
 
N� u ch� n Edit >> Preferences >> Display fields, b� n c�  th�  thay � � i c� ch EndNote hi� n th� v�  s#p x� p 
c� c t� i li� u tham kh� o tr� n m� n h�nh ch�nh. 
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V� d! : ch� n Reference Type t"  menu c&a c� t 5, c� c t� i li� u tham kh� o s)  � � 	 c hi� n th� theo lo� i h�nh t� i 
li� u (v� d! : b� i b� o, s� ch, vv.) ch�  kh� ng ph� i l�  s#p x� p theo URL. 
 
Nh� n n� t EndNote Defaults >> OK, b� n s)  thay � � i c� ch hi� n th� v�  d� ng ng� m � �nh ban � � u.  
 
Tìm t� i li� u tr�ch d
 n trong file – ph� " ng th� c tìm ki� m th�  nh#t 
 
� �  t�m ki� m nhanh t"  m� n h�nh ch�nh c&a EndNote (m� n h�nh hi� n th� t� c gi� , n� m xu� t b� n v�  t� n t� i 
li� u), b� n ch� c� n � � nh v� i ch�  c� i � � u h�  c&a t� c gi�  v�  t� i li� u � � u ti� n s)  � � 	 c b� i � en tr� n m� n h�nh. 
 
V� d! : 
Nh� p t"  gr  ± t� n c&a t� c gi�  Grand s)  � � 	 c l� m n� i b� t. 
N� u th�  vi� n � ang � � 	 c s#p x� p theo nhan � �  t� i li� u, b� n c�  th�  th� c hi� n l� nh t� $ng t�  v
 i 3 ch�  c� i 
� � u c&a t� n t� i li� u. 
Nh� n v� o ch�  Title �  � � u c� t � �  s#p x� p theo nhan � �  t� i li� u. 
Nh� p t"  up ± t� i li� u b#t � � u b ng The Upper Mantle s)  xu� t hi� n. 
 
L� u �  l�  l� nh t�m s)  lu� n ph!  thu� c v� o c� ch m�  th�  vi� n c&a b� n � � 	 c s#p x� p. 
 
Tìm t� i li� u tr�ch d
 n trong file – ph� " ng th� c tìm ki� m th�  hai 
 
N� u file d�  li� u c&a b� n l
 n, b� n c�  th�  c� n s�  d! ng ch� c n� ng t�m ki� m m� t t� i li� u c!  th� . 
 

T"  menu References, ch� n Search References ho
 c nh� n v� o bi� u t� 	 ng %ng nh
 m  tr� n thanh c� ng 
c!  ch�nh. 
 
� �  t�m t� t c�  c� c t� i li� u c�  ch� a t"  “ triceratops” trong file th� c h� nh paleo, nh� p t"  n� y v� o h� p tho� i 
t�m ki� m v�  nh� n n� t Search. B� n s)  t�m ra 2 t� i li� u tham kh� o. 
 

 
 
H� y xem k� t qu�  t�m ki� m v" a r+i. /  g� c d� 
 i b� n tr� i m� n h�nh EndNote s)  c�  c! m t"  "Showing 2 out 
of 208 references" (� ang hi� n th� 2 trong s% 208 t� i li� u tham kh� o). � i� u n� y c�  ngh.a l�  hi� n t� i nh� ng 
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t� i li� u c
 n l� i kh� ng � � 	 c hi� n th�. � �  c�  th�  xem l� i to� n b�  file EndNote, ch� n t"  menu 
References >> Show all references. B� n c( ng c�  th�  ph� i � � ng m� n h�nh t�m ki� m l� i. 
 
Tìm ki	 m trong các tr� 
 ng khác nhau  
 
B� n c� n l� m g� n� u nh�  b� n l� u th� ng tin v�  t� i li� u tham kh� o cho nh� ng b� i t� p/lu� n v� n kh� c nhau 
trong c� ng m� t file EndNote? B� n c�  th�  t�m t� t c�  c� c t� i li� u tham kh� o cho m� t b� i t� p, m� t ch� $ng 
lu� n v� n b ng c� ch s�  d! ng c� c tr� � ng nh�  Keywords hay Notes, th� � ng nh� ng tr� � ng n� y � �  tr%ng. 
 
V� d! , b� n c�  th�  nh� p ch�  Chapter  4 hay Ch� � ng 4 v� o tr� � ng Notes c&a b� t k,  t� i li� u tham kh� o 
n� o s)  � � 	 c s�  d! ng cho ch� $ng � � . Sau � �  b� n c�  th�  t�m t� t c�  c� c t� i li� u tham kh� o cho ch� $ng 4 
b ng c� ch nh� p t"  Chapter  4 ho
 c Ch� � ng 4 v� o m� n h�nh t�m ki� m v�  ch� n tr� � ng Notes trong menu 
d� c. 
 
Th�  n� o l�  term list v�  t� i sao chúng l� i h� u �ch? 
 
Term list (danh m! c thu� t ng� ) l�  ph� n m�  r� ng c&a nh� ng ph� $ng th� c t�m ki� m k�  tr� n. Ch� ng cho 
ph
 p b� n t� o m� t danh m! c t"  v� ng c�  ki� m so� t, th%ng nh� t v�  m
 t � �nh d� ng v�  ch�nh t� , qua � �  gi� p 
b� n ph	 n nh� m c� c t� i li� u tham kh� o. 
 
EndNote t�  � � ng c� p nh� t c� c thu� t ng�  trong 3 tr� � ng Author , Journals v�  Keywords, khi c�  b� t k,  
t� i li� u tham kh� o n� o � � 	 c b�  sung v� o file EndNote c&a b� n. B� n c�  th�  t#t ch� c n� ng t�  � � ng c� p 
nh� t n� y trong t� y ch� n Edit >> Preferences >> Term L ists. B� n c( ng c�  th�  t� o danh m! c thu� t ng�  
m
 i b ng c� ch s�  d! ng c� c tr� � ng kh� c nh�  Notes hay Label. M� i khi th� m m� t t� i li� u tham kh� o v� o 
file EndNote, b� n c�  th�  quy� t � �nh thu� t ng�  n� o n� n � � 	 c s�  d! ng cho t� i li� u � � , sau � �  b� n c�  th�  
t�m ki� m trong file EndNote t� t c�  c� c t� i li� u tham kh� o c�  thu� t ng�  � � . 
 
T� o m� t danh m
 c thu� t ng�  m� i 
 
T"  menu Tools, ch� n Define Term Lists sau � �  nh� n Create L ist. 
 

 
 
� 
 t t� n cho danh m! c n� y l�  Label v�  nh� n OK. 
 
V
 i ch�  Label � � 	 c b� i � en, nh� n v� o tab Terms: 
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Nh� n v� o n� t New Term v�  th� m m� t thu� t ng�  v� d!  nh�  introduction. Nh� n OK v�  th� m m� t s% 
thu� t ng�  n� a, v� d!  background v�  methodology. Ti� p � �  nh� n Close. 
 

 
 
K	 t n� i các danh m
 c thu� t ng�  
 
N� u b� n mu%n nh� ng thu� t ng�  n� y � � 	 c n%i v
 i nhau, � �  EndNote t�  � � ng nh� n ra m� t thu� t ng�  khi 
b� n b#t � � u gõ v� o b� n ph�m, nh� n v� o n� t Tools >> Link Term L ists. K
 o xu%ng ph� n Label trong 
c� c tr� � ng b� n tr� i v�  ch� n Label  t"  menu d� c. Nh� n OK. 
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C�  th�  l�  b� n c� n ph� i kh� i � � ng l� i EndNote � �  k�ch ho� t ch� c n� ng t�  � � ng nh� n d� ng (c� c tr� � ng 
author, keyword v�  journal � �  � � 	 c k� t n%i v
 i nhau). 
 
S�  d
 ng danh m
 c thu� t ng�  
 
M�  m� t t� i li� u tham kh� o trong file Paleo v�  k
 o chu� t xu%ng � �  ch� n tr� � ng Label. 
 
� � a con tr'  v� o tr� � ng n� y v�  nh� n v� o n� t Tools >> Open Term L ists >> Label Term L ist. Ch� n 
m� t trong s% c� c thu� t ng�  v�  nh� y k
 p v� o thu� t ng�  � �  � �  thu� t ng�  � � 	 c chèn v� o tr� � ng Label. N� u 
b� n � �  k� t n%i v
 i danh m! c thu� t ng� , b� n c
 n c�  th�  b#t � � u nh� p m� t trong s% c� c thu� t ng�  v�  n�  s)  
t�  � � ng � � 	 c chèn v� o t� i li� u tham kh� o. 
 
� � ng t� i li� u tham kh� o n� y l� i v�  th�  t�m thu� t ng�  m�  b� n � �  nh� p v� o tr� � ng Label (References >> 
Search References).  
 
Nh
 p kh� u c� c danh m� c thu
 t ng�  l�  nhan � �  th$ng nh#t c%a c%a c� c t�  b� o  
 
M� t s% ki� u tr�ch d� n, v� d!  nh�  trong l.nh v� c y t� , y� u c� u b� n chèn t� n c� c t�  b� o, t� p ch� chuy� n 
ng� nh l�  c� c t"  vi� t t#t. Thay v� o vi� c ph� i t�  � � nh l� i t� n chi ti� t c&a t� t c�  c� c t�  b� o, b� n c�  th�  nh� p 
kh� u tr� c ti� p t"  EndNote m� t s% danh m! c t� n c&a c� c t�  b� o, t� p ch� chuy� n ng� nh, bao g+m c�  t� n 
vi� t t#t. 
 
EndNote cung c� p danh m! c t� n c� c t�  b� o, t� p ch� chuy� n ng� nh trong l.nh v� c y h� c, h� a h� c v�  nh	 n 
v� n. N� u b� n mu%n s�  d! ng nh� ng danh m! c n� y, b� n c� n ph� i nh� p kh� u ch� ng v� o trong file EndNote 
c&a b� n. 
 
� �  nh� p kh� u danh m! c c� c t�  b� o, t� p ch� chuy� n ng� nh v�  y t� , t"  menu Tools, ch� n Open Term 
L ists >> Journals Term List  >> L ists. 
 
T"  tab L ists, ch� n Impor t L ist v�  t�m danh m! c y t�  (Medical list) trong �  C:\Program 
Files\EndNote\Term L ists.  
 
Nh� n v� o file Medical.txt � �  b� i � en file v�  nh� n Open. 
 
� � ng danh m! c n� y l� i sau khi b� n � �  k� t th� c vi� c nh� p kh� u d�  li� u. 
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S�  d� ng c� c nhóm (Groups) 
 
Ch� c n� ng Groups cho ph
 p b� n t�  ch� c c� c t� i li� u tham kh� o c&a m�nh th� nh c� c nh� m nh'  m�  kh� ng 
c� n t� o m� t file ri� ng bi� t. C� c nh� m c�  nh	 n h� a � � 	 c ng� � i s�  d! ng t�  t� o ra. Ô Groups hi� n th� �  c� t 
b� n tr� i, n� u kh� ng th� c�  th�  nh� n v� o bi� u t� 	 ng Show/Hide Groups ho
 c v� o menu Tools >> Show 
Groups. C�  th�  � � i t� n c&a nh� m ho
 c v�  x� a nh� m, ho
 c l�  x� a c� c bi� u ghi trong m� t nh� m, tuy 
nhi� n th� ng tin g%c v�  c� c t� i li� u trong file th�  vi� n c&a b� n v� n � � 	 c gi�  nguy� n. M� i reference 
(th� ng tin v�  m� t t� i li� u) c�  th�  � � 	 c � � a v� o nhi� u nh� m kh� c nhau.  
 
B�  sung m� t nhóm  
 
T"  menu References ch� n Groups v�  Create New Group, ho
 c c�  th�  nh� n chu� t ph� i v� o �  Groups 
v�  ch� n Create New Group. M� t nh� m m
 i s)  hi� n ra trong c� t Groups v�  b� n c�  th�  � 
 t t� n nh� m t� y 
� , v� d!  Bai tap 1. 
 
B�  sung th� ng tin v�  t� i li� u tham kh� o v� o nhóm  
 
Ch� n t� i li� u c� n thi� t, v� o menu References v�  ch� n Add Reference To sau � �  ch� n nh� m ph�  h	 p, 
ho
 c nh� n chu� t ph� i v� o t� i li� u c� n ch� n v�  ch� n Add Reference To sau � �  ch� n nh� m ph�  h	 p. � �  
xem c� c t� i li� u � �  c�  trong m� t nh� m, ch� c� n nh� n chu� t v� o t� n nh� m � � . 
 

" � � � �# U$�C� � � > � � � � � � � � � � � � � � � � �6 � � � �
 
M� u b� n th� o (Manuscript Templates) 
 
N� u b� n � ang vi� t lu� n v� n, ho
 c vi� t m� t b� i b� o cho m� t t� p ch� chuy� n ng� nh, nh� ng m� u b� i vi� t 
n� y c�  th�  c�  �ch cho b� n v� ch� ng cung c� p h� 
 ng d� n l� m cho qu�  tr�nh vi� t c&a b� n � � 	 c d* d� ng 
h$n. EndNote c�  c� c m� u b� i vi� t cho m� t s% kh�  l
 n c� c t�  b� o v�  c� c m� u lu� n v� n nh�  MLA hay 
APA. Ch� ng � � 	 c m�  ra trong ch� $ng tr�nh Word. 
 
� �  m�  m� t m� u b� n th� o 
 
T"  Tools, ch� n Manuscr ipt Templates. Trong th�  m! c templates trong EndNote, ch� n t� n c&a t� p ch� 
m�  b� n c� n r+i nh� n Open. M� u b� i vi� t s)  xu� t hi� n � �  b� n nh� p v� n b� n. 
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B�  các mã tr� 
 ng trong file v� n b� n � ã hoàn thi� n  
 
N� u b� n � �  ho� n th� nh b� i vi� t, b� n mu%n x� a c� c k� t n%i trong v� n b� n c&a m�nh t
 i file EndNote. � �  

l� m vi� c n� y, b� n m�  v� n b� n Word v�  nh� n v� o n� t Remove field codes  tr� n thanh c� ng c!  
EndNote trong file Word.  
 
M� t b� n sao kh� c c&a v� n b� n, kh� ng c�  m�  tr� � ng, s)  hi� n ra trong m� t c� a s�  m
 i. H� y l� u v� n b� n 
n� y l� i b ng m� t t� n file kh� c. L� u �  l�  b� n kh� ng � �  � �nh d� ng l� i c� c t� i li� u tham kh� o trong file m
 i 
n� y, tuy nhi� n b� n c�  th�  � �nh d� ng l� i trong file g%c.  
 

" � � � �# # $�%�� �1 �R� � � � V� � �W � � � � � � � � � � � � � � � �
 
Tìm tr�  giúp trong EndNote 
 
C�  nhi� u c� ch � �  t�m tr	  gi� p n� u b� n g
 p kh�  kh� n khi s�  d! ng EndNote. 
 

·  Ch� $ng tr�nh EndNote c�  c� ng c!  tr	  gi� p Help. 
 

 
 
·  EndNote c( ng cung c� p m� t t� i li� u h� 
 ng d� n s�  d! ng r� t � � y � & b ng ti� ng Anh trong th�  m! c 

EndNote.  
·  Trang web c&a EndNote http://www.endnote.com c�  ph� n FAQs (c� c c	 u h' i th� � ng g
 p) v�  

cho ph
 p ng� � i s�  d! ng g� i email � �  y� u c� u tr	  gi� p v�  k-  thu� t (v� d! : v� n � �  t� $ng th�ch gi� a 
EndNote v�  Word). 

 
(N� i dung c� a tài li
 u này d�ch t� : 
http://library.curtin.edu.au/research_and_information_skills/online_tutorials/endnote_steps/index.html) 
 


